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Introducción

Para obtener colores con la mayor precisión en sus impresiones, puede usar perfiles 
diseñados específicamente para el modelo de su impresora y tipo de papel. Los 
perfiles básicos se instalan con el driver de la impresora y es posible que también 
haya descargado los perfiles Premium ICC de Epson cuando instaló el software de 
la impresora.

Para imprimir utilizando perfiles Premium ICC con Adobe® Photoshop® CC, 
CS6, CS5 o Adobe Photoshop Lightroom®, siga las instrucciones de estas 
secciones para su sistema operativo:

■ “Windows 8 y Windows 7” a continuación

■ “Mac OS X 10.8 y 10.7” en la página 21

Windows 8 y Windows 7

Siga las instrucciones que se indican en estas secciones:

■ “Cómo imprimir con Adobe Photoshop CC o CS6” a continuación

■ “Cómo imprimir con Adobe Photoshop CS5” en la página 9

■ “Cómo imprimir con Adobe Photoshop Lightroom” en la página 16

Cómo imprimir con Adobe Photoshop CC o CS6

Primero debe configurar el entorno de gestión de color en Photoshop y asignar un 
perfil a su imagen. Luego, seleccione sus ajustes de impresión e imprima su 
archivo.

Nota:

Asignarle un perfil a la imagen no modifica la imagen, sólo su interpretación por el 
software y su apariencia en el monitor y en la impresión. Esta es la mejor manera de 
mejorar el equilibrio de color y el contraste de su imagen.
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Cómo configurar un entorno en Photoshop

1. Abra el programa Photoshop.

2. Seleccione Edición > Ajustes de color.

3. Seleccione Preimpresión en Norteamérica 2 en el menú Ajustes para 
establecer Adobe RGB (1998) como el espacio de trabajo RGB y activar los 
mensajes de perfiles.

4. Haga clic en OK.

Siga los pasos de la siguiente sección para abrir la foto que desea imprimir y 
asignarle un perfil.
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Cómo asignar un perfil a su foto

1. Abra la foto que desea imprimir.

2. Si aparece el mensaje Diferencia de perfil incrustado, seleccione Usar el perfil 
incrustado (en lugar del espacio de trabajo) y haga clic en OK.

Si aparece el mensaje Falta el perfil, seleccione Asignar espacio de trabajo 
RGB: Adobe RGB (1998) y haga clic en OK. Cuando aparezca su imagen, 
evalúe el equilibrio de color y el contraste que aparecen en el monitor. Si se ve 
incorrecto, seleccione Edición > Asignar perfil.

Nota:

Si aparece un cuadro de diálogo con un mensaje acerca de la apariencia de capas, 
haga clic en OK.

Seleccione una de las siguientes opciones como el ajuste Perfil:

■ un área de trabajo RGB (o Perfil) diferente, como sRGB IEC61966-2.1

■ un perfil de cámara para su cámara digital

■ un perfil de escáner para su escáner

También haga clic en la casilla de verificación Previsualizar para poder ver en 
pantalla los efectos del perfil seleccionado.

Consejo:

Esto resulta más eficaz cuando su monitor está calibrado con un dispositivo 
de hardware, tal como X-Rite® ColorMunki™ Display, i1 Display Pro o Datacolor® 
Spyder™.

3. Haga clic en OK.

4. Seleccione Archivo, luego seleccione Imprimir.
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5. Seleccione su impresora profesional Epson en la lista desplegable Impresora.

6. Para el ajuste Administración de color, seleccione Photoshop gestiona 
los colores.

7. Para el Perfil de impresora, seleccione un perfil para su impresora y para el tipo 
de papel que va a utilizar. Si va a imprimir con perfiles Premium ICC de 
Epson, seleccione el perfil que también coincide con la calidad de impresión 
que desea utilizar.

8. Para el ajuste Interpretación, seleccione Colorimétrico relativo.

Nota:

Si su imagen contiene colores muy saturados, seleccione Perceptual. Esto reduce 
la saturación del color para que los colores se ajusten a la gama de colores de la 
impresora.

9. Seleccione la casilla de verificación Compensación de punto negro.

10. Haga clic en el botón Ajustes de impresión.

Siga los pasos de la siguiente sección para seleccionar ajustes de impresión que 
coincidan con el perfil e imprimir su archivo.
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Cómo imprimir su fotografía con gestión de color

1. Seleccione los ajustes Origen y Tipo papel para el papel que va a utilizar para 
imprimir.

2. Seleccione Opciones de Calidad como el ajuste Resolución.

Verá una ventana como ésta:

3. Si va a utilizar un perfil Premium ICC de Epson, configure el ajuste 
Resolución para que corresponda a su perfil.

4. Desactive las opciones Bidireccional y Suavizado, si están disponibles, 
luego haga clic en Aceptar para cerrar la ventana Opciones de Calidad.
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5. Seleccione Personaliz como el ajuste Modo, luego seleccione Desactivado 
(Sin Ajuste de Color) en el menú desplegable.

Nota:

Asegúrese de seleccionar Desactivado (Sin Ajuste de Color). De lo contrario, 
el driver de la impresora realizará correcciones adicionales a la imagen, 
produciendo resultados imprecisos.

6. Haga clic en Aceptar.
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7. Seleccione el ajuste Composición correcto según la orientación de su foto.

8. Haga clic en Imprimir para imprimir su foto.

Si obtiene resultados inesperados, consulte la sección “Resolución de problemas de 
gestión de color” en la página 35.

Cómo imprimir con Adobe Photoshop CS5

Nota:

Algunas de las pantallas en esta sección solamente están disponibles en inglés.

Primero debe configurar el entorno de gestión de color en Photoshop y asignar un 
perfil a su imagen. Luego, seleccione sus ajustes de impresión e imprima su 
archivo.

Nota:

Asignarle un perfil a la imagen no modifica la imagen, sólo su interpretación por el 
software y su apariencia en el monitor y en la impresión. Esta es la mejor manera de 
mejorar el equilibrio de color y el contraste de su imagen.
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Cómo configurar un entorno en Photoshop

1. Abra el programa Photoshop.

2. Seleccione Edit > Color Settings (Edición > Ajustes de color).

3. Seleccione North America Prepress 2 (Preimpresión en Norteamérica 2) en 
el menú Settings (Ajustes) para establecer Adobe RGB (1998) como el espacio 
de trabajo RGB y activar los mensajes de perfiles.

4. Haga clic en OK.

Siga los pasos de la siguiente sección para abrir la foto que desea imprimir y 
asignarle un perfil.



Cómo imprimir con Adobe Photoshop CS5 11

Cómo asignar un perfil a su foto

1. Abra la foto que desea imprimir.

2. Si aparece el mensaje Embedded Profile Mismatch (Diferencia de perfil 
incrustado), seleccione Use the embedded profile (instead of the 
working space) (Usar el perfil incrustado [en lugar del espacio de trabajo]) 
y haga clic en OK.

Si aparece el mensaje Missing Profile (Falta el perfil), seleccione Assign 
working RGB: Adobe RGB (1998) (Asignar espacio de trabajo RGB: Adobe 
RGB [1998]) y haga clic en OK. Cuando aparezca su imagen, evalúe el 
equilibrio de color y el contraste que aparecen en el monitor. Si se ve 
incorrecto, seleccione Edit > Assign profile (Edición > Asignar perfil).

Seleccione una de las siguientes opciones como el ajuste Profile (Perfil):

■ un área de trabajo RGB (o Perfil) diferente, como sRGB IEC61966-2.1

■ un perfil de cámara para su cámara digital

■ un perfil de escáner para su escáner

También haga clic en la casilla de verificación Preview (Previsualizar) para 
poder ver en pantalla los efectos del perfil seleccionado.

Consejo:

Esto resulta más eficaz cuando su monitor está calibrado con un dispositivo de 
hardware, tal como X-Rite ColorMunki Display, i1 Display Pro o Datacolor Spyder.

3. Haga clic en OK.

4. Seleccione File (Archivo), luego seleccione Print (Imprimir).
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5. Seleccione su impresora profesional Epson en la lista desplegable Printer 
(Impresora), luego seleccione Color Management (Gestión de color).

6. Para el ajuste Color Handling (Administración de color), seleccione 
Photoshop Manages Colors (Photoshop gestiona los colores).

7. Para el Printer Profile (Perfil de impresora), seleccione un perfil para su 
impresora y para el tipo de papel que va a utilizar. Si va a imprimir con perfiles 
Premium ICC de Epson, seleccione el perfil que también coincide con la 
calidad de impresión que desea utilizar.

8. Para el ajuste Rendering Intenet (Interpretación), seleccione Relative 
Colorimetric (Colorimétrico relativo).

Nota:

Si su imagen contiene colores muy saturados, seleccione Perceptual. Esto reduce 
la saturación del color para que los colores se ajusten a la gama de colores de la 
impresora.

9. Seleccione la casilla de verificación Black Point Compensation 
(Compensación de punto negro).

10. Haga clic en el botón Print Settings (Ajustes de impresión).
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Siga los pasos de la siguiente sección para seleccionar ajustes de impresión que 
coincidan con el perfil e imprimir su archivo.

Cómo imprimir su fotografía con gestión de color

1. Seleccione los ajustes Origen y Tipo papel para el papel que va a utilizar para 
imprimir.

2. Seleccione Opciones de Calidad como el ajuste Resolución.

Verá una ventana como ésta:

3. Si va a utilizar un perfil Premium ICC de Epson, configure el ajuste 
Resolución para que corresponda a su perfil.

4. Desactive las opciones Bidireccional y Suavizado, si están disponibles, 
luego haga clic en Aceptar para cerrar la ventana Opciones de Calidad.
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5. Seleccione Personaliz como el ajuste Modo, luego seleccione Desactivado 
(Sin Ajuste de Color) en el menú desplegable.

Nota:

Asegúrese de seleccionar Desactivado (Sin Ajuste de Color). De lo contrario, el 
driver de la impresora realizará correcciones adicionales a la imagen, produciendo 
resultados imprecisos.

6. Haga clic en Aceptar.
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7. Seleccione la orientación correcta para su foto.

8. Haga clic en Print (Imprimir) para imprimir su foto.

Si obtiene resultados inesperados, consulte la sección “Resolución de problemas de 
gestión de color” en la página 35.
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Cómo imprimir con Adobe Photoshop 
Lightroom

Esta sección explica cómo configurar el entorno de impresión en Lightroom.

Cómo seleccionar las opciones de gestión de color

1. Abra el programa Lightroom.

2. Seleccione la foto que desea imprimir.

3. Haga clic en el botón Ajustar página.

4. Compruebe que su impresora profesional Epson esté seleccionada.
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5. Seleccione el Tamaño del papel, el Origen que usará para cargarlo y la 
Orientación para su foto.

6. Haga clic en Aceptar.

7. Desplácese hacia abajo al panel Trabajo de impresión en Lightroom.

8. Debajo de Gestión de color en el panel Trabajo de impresión, seleccione Otro 
como el ajuste Perfil.
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9. En la ventana que aparece, seleccione los perfiles que desea añadir a la lista 
Perfil que corresponden a la impresora y a los papeles que va a utilizar.

Si va a imprimir con perfiles Premium ICC de Epson, seleccione los perfiles 
que también coinciden con la Resolución que desea utilizar.

10. Haga clic en OK.

11. Debajo de Perfil, seleccione el perfil para el papel que va a utilizar para 
imprimir. Si va a imprimir con perfiles Premium ICC de Epson, seleccione el 
perfil que también coincide con la calidad de impresión que desea utilizar.
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12. Para el ajuste Interpretación, seleccione Relativa.

Nota:

Si su imagen contiene colores muy saturados, seleccione Perceptual. Esto reduce 
la saturación del color para que los colores se ajusten a la gama de colores de la 
impresora.

13. Haga clic en el botón Imprimir una para imprimir su foto.

Siga los pasos de la siguiente sección para seleccionar ajustes de impresión que 
coincidan con el perfil e imprimir su archivo.

Cómo imprimir su fotografía con gestión de color

1. Compruebe que su impresora profesional Epson esté seleccionada, luego haga 
clic en el botón Preferencias o Propiedades.

2. Seleccione los ajustes Origen y Tipo papel para el papel que va a utilizar para 
imprimir.

3. Seleccione Opciones de Calidad como el ajuste Resolución.

Verá una ventana como ésta:

4. Desactive las opciones Bidireccional y Suavizado, si están disponibles, luego 
haga clic en Aceptar para cerrar la ventana Opciones de Calidad.
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5. Seleccione Personaliz como el ajuste Modo, luego seleccione Desactivado 
(Sin Ajuste de Color) en el menú desplegable.

Nota:

Asegúrese de seleccionar Desactivado (Sin Ajuste de Color). De lo contrario, el 
driver de la impresora realizará correcciones adicionales a la imagen, produciendo 
resultados imprecisos.

6. Haga clic en Aceptar para imprimir.

Si obtiene resultados inesperados, consulte la sección “Resolución de problemas de 
gestión de color” en la página 35.
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Mac OS X 10.8 y 10.7

Siga las instrucciones que se indican en estas secciones:

■ “Cómo imprimir con Adobe Photoshop CC o CS6” a continuación

■ “Cómo imprimir con Adobe Photoshop CS5” en la página 25

■ “Cómo imprimir con Adobe Photoshop Lightroom” en la página 30

Cómo imprimir con Adobe Photoshop CC o CS6

Primero debe configurar el entorno de gestión de color en Photoshop y asignar 
un perfil a su imagen. Luego, seleccione sus ajustes de impresión e imprima 
su archivo.

Nota:

Asignarle un perfil a la imagen no modifica la imagen, sólo su interpretación por el 
software y su apariencia en el monitor y en la impresión. Esta es la mejor manera de 
mejorar el equilibrio de color y el contraste de su imagen.

Cómo configurar un entorno en Photoshop

1. Abra el programa Photoshop.

2. Seleccione Edición > Ajustes de color.
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3. Seleccione Preimpresión en Norteamérica 2 en el menú Ajustes para 
establecer Adobe RGB (1998) como el espacio de trabajo RGB y activar los 
mensajes de perfiles.

4. Haga clic en OK.

Siga los pasos de la siguiente sección para abrir la foto que desea imprimir y 
asignarle un perfil.

Cómo asignar un perfil a su foto

1. Abra la foto que desea imprimir.

2. Si aparece el mensaje Diferencia de perfil incrustado, seleccione Usar el perfil 
incrustado (en lugar del espacio de trabajo) y haga clic en OK.

Si aparece el mensaje Falta el perfil, seleccione Asignar espacio de trabajo 
RGB: Adobe RGB (1998) y haga clic en OK. Cuando aparezca su imagen, 
evalúe el equilibrio de color y el contraste que aparecen en el monitor. Si se 
ve incorrecto, seleccione Edición > Asignar perfil.

Nota:

Si aparece un cuadro de diálogo con un mensaje acerca de la apariencia de capas, 
haga clic en OK.

Seleccione una de las siguientes opciones como el ajuste Perfil:

■ un área de trabajo RGB (o Perfil) diferente, como sRGB IEC61966-2.1

■ un perfil de cámara para su cámara digital

■ un perfil de escáner para su escáner

También haga clic en la casilla de verificación Previsualizar para poder ver en 
pantalla los efectos del perfil seleccionado.

Consejo:

Esto resulta más eficaz cuando su monitor está calibrado con un dispositivo de 
hardware, tal como X-Rite ColorMunki Display, i1 Display Pro o Datacolor Spyder.

3. Haga clic en OK.
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4. Seleccione Archivo > Imprimir.

5. Seleccione su impresora profesional Epson en la lista desplegable Impresora.

6. Para el ajuste Administración de color, seleccione Photoshop gestiona los 
colores.

7. Para el Perfil de impresora, seleccione un perfil para su impresora y para el tipo 
de papel que va a utilizar. Si va a imprimir con perfiles Premium ICC de 
Epson, seleccione el perfil que también coincide con la calidad de impresión 
que desea utilizar.

8. Para el ajuste Interpretación, seleccione Colorimétrico relativo.

Nota:

Si su imagen contiene colores muy saturados, seleccione Perceptual. Esto reduce 
la saturación del color para que los colores se ajusten a la gama de colores de la 
impresora.

9. Seleccione la casilla de verificación Compensación de punto negro.

10. Haga clic en el botón Ajustes de impresión.

Siga los pasos de la siguiente sección para seleccionar ajustes de impresión que 
coincidan con el perfil e imprimir su archivo.
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Cómo imprimir su fotografía con gestión de color

1. Seleccione su impresora profesional Epson en la lista desplegable Impresora.

2. Haga clic en Mostrar detalles o d para expandir la ventana Imprimir, si es 
necesario.

3. Seleccione los ajustes de tamaño y recorrido del papel que coincidan con el 
papel que va a utilizar para imprimir.

Consejo:

Si va a utilizar papel para bellas artes, asegúrese de elegir el recorrido de papel 
correcto o las opciones de tipo de papel se desactivarán.

4. Seleccione Ajustes Impresión en el menú desplegable.

5. Seleccione el ajuste Tipo papel para el papel que va a utilizar para imprimir.

Nota:

La opción Desactivado (Sin Ajuste de Color) aparecerá en el menú desplegable 
Ajustes del color.

6. Si está utilizando un perfil Premium ICC de Epson, configure el ajuste 
Resolución para que coincida con el perfil.

7. Haga clic en Guardar.
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8. Seleccione el ajuste Composición correcto según la orientación de su foto.

9. Haga clic en Imprimir para imprimir su foto.

Si obtiene resultados inesperados, consulte la sección “Resolución de problemas de 
gestión de color” en la página 35.

Cómo imprimir con Adobe Photoshop CS5

Nota:

Algunas de las pantallas en esta sección solamente están disponibles en inglés.

Primero debe configurar el entorno de gestión de color en Photoshop y asignar 
un perfil a su imagen. Luego, seleccione sus ajustes de impresión e imprima 
su archivo.

Nota:

Asignarle un perfil a la imagen no modifica la imagen, sólo su interpretación por el 
software y su apariencia en el monitor y en la impresión. Esta es la mejor manera de 
mejorar el equilibrio de color y el contraste de su imagen.
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Cómo configurar un entorno en Photoshop

1. Abra el programa Photoshop.

2. Seleccione Edit > Color Settings (Edición > Ajustes de color).

3. Seleccione North America Prepress 2 (Preimpresión en Norteamérica 2) en 
el menú Settings (Ajustes) para establecer Adobe RGB (1998) como el espacio 
de trabajo RGB y activar los mensajes de perfiles.

4. Haga clic en OK.

Siga los pasos de la siguiente sección para abrir la foto que desea imprimir y 
asignarle un perfil.

Cómo asignar un perfil a su foto

1. Abra la foto que desea imprimir.

2. Si aparece el mensaje Embedded Profile Mismatch (Diferencia de perfil 
incrustado), seleccione Use the embedded profiles (Usar el perfil 
incrustado) y haga clic en OK.

Si aparece el mensaje Missing Profile (Falta el perfil), seleccione Assign 
working RGB: Adobe RGB (1998) (Asignar espacio de trabajo RGB: Adobe 
RGB [1998]) y haga clic en OK. Cuando aparezca su imagen, evalúe el 
equilibrio de color y el contraste que aparecen en el monitor. Si se ve 
incorrecto, seleccione Edit > Assign Profile (Edición > Asignar perfil).
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Seleccione una de las siguientes opciones como el ajuste Profile (Perfil):

■ un área de trabajo RGB (o Perfil) diferente, como sRGB IEC61966-2.1

■ un perfil de cámara para su cámara digital

■ un perfil de escáner para su escáner

También haga clic en la casilla de verificación Preview (Previsualizar) para 
poder ver en pantalla los efectos del perfil seleccionado.

Consejo:

Esto resulta más eficaz cuando su monitor está calibrado con un dispositivo de 
hardware, tal como X-Rite ColorMunki Display, i1 Display Pro o Datacolor Spyder.

3. Haga clic en OK.

4. Seleccione File > Print (Archivo > Imprimir).

5. Seleccione su impresora profesional Epson en lista desplegable Printer 
(Impresora).

6. Debajo de Color Management (Gestión de color), seleccione Document 
(Document).
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7. Debajo de Color Handling (Administración de color), seleccione Photoshop 
Manages Colors (Photoshop gestiona los colores).

8. Debajo de Printer Profile (Perfil de impresora), seleccione un perfil para su 
impresora y para el tipo de papel que va a utilizar. Si va a imprimir con perfiles 
Premium ICC de Epson, seleccione el perfil que también coincide con la 
calidad de impresión que desea utilizar.

9. Para el ajuste Rendering Intent (Interpretación), seleccione Relative 
Colorimetric (Colorimétrico relativo).

Nota:

Si su imagen contiene colores muy saturados, seleccione Perceptual. Esto reduce 
la saturación del color para que los colores se ajusten a la gama de colores de la 
impresora.

10. Seleccione la casilla de verificación Black Point Compensation 
(Compensación de punto negro).

11. Haga clic en el botón Print Settings (Ajustes de impresión).

Siga los pasos de la siguiente sección para seleccionar ajustes de impresión que 
coincidan con el perfil e imprimir su archivo.

Cómo imprimir su fotografía con gestión de color

1. Seleccione su impresora profesional Epson en la lista desplegable Impresora.

2. Haga clic en Mostrar detalles o d para expandir la ventana Imprimir, si es 
necesario.

3. Seleccione los ajustes de tamaño y recorrido del papel que coincidan con el 
papel que va a utilizar para imprimir.

Consejo:

Si va a utilizar papel para bellas artes, asegúrese de elegir el recorrido de papel 
correcto o las opciones de tipo de papel se desactivarán.

4. Seleccione Ajustes Impresión en el menú desplegable.
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5. Seleccione el ajuste Tipo papel para el papel que va a utilizar para imprimir.

Nota:

La opción Desactivado (Sin Ajuste de Color) aparecerá en el menú desplegable 
Ajustes del color.

6. Si está utilizando un perfil Premium ICC de Epson, configure el ajuste 
Resolución para que coincida con el perfil.

7. Haga clic en Guardar.
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8. Seleccione la orientación correcta para su foto.

9. Haga clic en Print (Imprimir) para imprimir su foto.

Si obtiene resultados inesperados, consulte la sección “Resolución de problemas de 
gestión de color” en la página 35.

Cómo imprimir con Adobe Photoshop 
Lightroom

Esta sección explica cómo configurar el entorno de impresión en Lightroom.

Cómo seleccionar las opciones de gestión de color

1. Abra el programa Lightroom.

2. Seleccione la foto que desea imprimir.
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3. Haga clic en el botón Ajustar página.

4. Seleccione su impresora profesional Epson en el menú desplegable 
Formato para.

5. Seleccione los ajustes de tamaño y recorrido del papel que coincidan con el 
papel que va a utilizar para imprimir.

Consejo:

Si va a utilizar papel para bellas artes, asegúrese de elegir el recorrido de papel 
correcto o las opciones de tipo de papel se desactivarán.

6. Seleccione la Orientación para su foto.

7. Haga clic en Aceptar.
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8. Desplácese hacia abajo al panel Trabajo de impresión en Lightroom.

9. Debajo de Gestión de color en el panel Trabajo de impresión, seleccione Otro 
como el ajuste Perfil.

10. En la ventana que aparece, seleccione los perfiles que desea añadir a la lista 
Perfil que corresponden a la impresora y a los papeles que va a utilizar.

Si va a imprimir con perfiles Premium ICC de Epson, seleccione los perfiles 
que también coinciden con la calidad de impresión que desea utilizar.

11. Haga clic en OK.
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12. Debajo de Perfil, seleccione el perfil para el papel que va a utilizar para 
imprimir. Si va a imprimir con perfiles Premium ICC de Epson, seleccione el 
perfil que también coincide con la calidad de impresión que desea utilizar.

13. Para el ajuste Interpretación, seleccione Relativa.

Nota:

Si su imagen contiene colores muy saturados, seleccione Perceptual. Esto reduce 
la saturación del color para que los colores se ajusten a la gama de colores de la 
impresora.

14. Haga clic en el botón Imprimir una.

Siga los pasos de la siguiente sección para seleccionar ajustes de impresión que 
coincidan con el perfil e imprimir su archivo.

Cómo imprimir su fotografía con gestión de color

1. Seleccione su impresora profesional Epson en la lista desplegable Impresora.

2. Haga clic en Mostrar detalles o d para expandir la ventana Imprimir, si es 
necesario.

3. Seleccione Ajustes Impresión en el menú desplegable.
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4. Seleccione el ajuste Tipo papel para el papel que va a utilizar para imprimir.

Nota:

La opción Desactivado (Sin Ajuste de Color) aparecerá en el menú desplegable 
Ajustes del color.

5. Si está utilizando un perfil Premium ICC de Epson, configure el ajuste 
Resolución para que coincida con el perfil.

6. Haga clic en Guardar, luego haga clic en Imprimir una para imprimir 
su foto.

Si obtiene resultados inesperados, consulte la sección “Resolución de problemas de 
gestión de color” en la página 35.
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Resolución de problemas de gestión 
de color

Si selecciona una combinación incorrecta de ajustes de perfil de origen, perfil de 
impresora y gestión de color, obtendrá resultados diferentes de los esperados. 
Pruebe las siguientes soluciones:

■ Si la imagen impresa aparece más oscura de lo esperado, es posible que haya 
desactivado la gestión de color tanto en la aplicación como en el driver de la 
impresora Epson.

En Photoshop, vuelva a consultar las instrucciones de impresión para 
Windows o Mac OS X 10.8 y 10.7. Compruebe que la opción Documento no 
esté configurado como RGB sin etiqueta. Asegúrese también de seleccionar el 
perfil correcto para su impresora en el menú Perfil.

En Lightroom, seleccione el perfil para el papel que va a utilizar para imprimir 
como el ajuste Perfil. Si va a imprimir con perfiles Premium ICC de Epson, 
seleccione el perfil que también coincide con la calidad de impresión 
seleccionada.

■ Si la imagen impresa aparece más tenue de lo esperado, es posible que haya 
activado la gestión de color tanto en Photoshop como en el driver de la 
impresora Epson.

Seleccione el ajuste Desactivado (Sin Ajuste de Color) en Windows o en 
Mac OS X 10.8 y 10.7 para desactivar la gestión de color en el driver de la 
impresora Epson.
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